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The Goal of This Webinar

- For those of you who are new to accessible document design, the goal of the
webinar is to show you the tools you have in Word to make more accessible
documents.

- We are learning more about accessible document design and are constantly
updating our tools and our capability to improve the accessibility of digital
content.

- These are the basic tools in your toolkit!
- You don’t have to do everything “by midnight tonight.”

- Create a learning plan and add the accessibility as you incorporate the |
techniques available to you. [




Document Templates

If you create more than one type of document, create a document template.

- For example, newsletter, letterhead, report, flyer and so forth.
- File/Backstage area, Save As, Word Template.

+ Instead of saving your Word document as “Word Document” or DOCX, save it
as “Word Template” or DOTX.

« This will place the template in the Custom Office Templates folder on your hard
drive.

- Use it by going to the File/Backstage area, New and choosing it from the
Personal Templates.
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Save As...Document Template

Document] - Yéard

©

Save As

ey
1\ Documents
Onen @ Recent
i Report
Sy Word Docurment (% docx) - E.r} Save
ﬁ OneDrive - Personal o1 BN 14 (PP
Save As kdmceall@rogers.com
\ #leia ) QOneDrive - Personal s Date modified
s kdrnccall@outiook.corn "
2017-03-14 100718 AR
Print = _ -
E:I This PC
LI =

S 2017-05-17 8:35 AM




Save As...Document Template - 2
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Use F12 to Save As...Word Template
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Templates Gallery in Word
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Styles are the Foundation of Accessibility

As much as possible, do not use “direct formatting” such as Bold, Italic or
Underline.

« Use Strong and Emphasis Styles. Create an Underline Style.
- If you want to change the font or font size, modify the Normal Style.

« Alot can be done with Styles including creating a Style that looks like a call out
or sidebar but is 100% accessible.

- Avoid using Text Boxes and single cell tables to call out important content.

- Use a standard font like Calibri or Cambria. Verdana is a display font and may
not work well if the document is printed. l
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Direct Formatting is an Accessibility Barrier

Background

For example, vou can add a matching cover page, header, and sidebar, Click Insert and then
choose the elements youwant from the different galleries, Themes and styles also help
keap your document coordinated, When you click Design and choose a new Theme, the
picturas, charts, and Smarthrt graphics change to match your new theme,
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Flinging Formatting is an Accessibility Barrier

Introduction

Video provides a powerfulway to help you prove your point. When you click Online Video,
you can paste in the embed code for the video youwant to add. You canalsotype a
keyword to search online for the video that best fits your document.,

To make your document look professionally produced, Word provides header, focter, cover
page, and text box designs that complement each other. For example, you can add a
matching cover page, header, and sidebar. Click Insert and then choosethe elaments you
want from the different galleries,

Background Information

Themes and styles also help keep your document coordinated. When wou click Design and
choose a new Theme, the pictures, charts, and Smartart graphics change to match your
new theme, When you apply styles, your headings change to match the new theme.

Savetime in Word with new buttonsthat show upwhereyou need them. To change the
way a pleture fits in your document, click it and a button for layout options appears nextto
it. When vouwork on atable, click where vouwant to add arow or a column, and then click
the plus sign.

Chapter One - Style is Everything!

Reading is easier, too, in the new Readingview, You can collapse parts ofthe document and
focus on the text you want. If vou need to stop reading before you reach the end, Word
rememberswhere you left off - even on another device,

Wideo provides a powerful way to help you prove your point. When you click Online Video,
you can paste in the embed code for the video youwant to add. You can also type a
keyword to search online for the video that best fits your document,

Introduction

“Vidao provides a powerful way to help you prove your point. When you click Online Vides,
wou can paste in the embed code for the vidao you want to add. You can alsotypa a
keyword to search online for the video that best fits your document.

To make vour document look professionally produced, Word provides header, footer, cover
page, and text box designs that complement each other, For example, youcanadd a
matching cover page, header, and sidebar. Click Insertand than choosetha elements you

want from the different galleries.
Background Information

Themes and styles also help keep vour document coordinated. When you click Design and
choose a new Theme, the pictures, charts, and Smartfrt graphics change to match your
new theme, When vou apply styles, vour headings change to match the new theme.

Savetime in Word with new buttons that show up whereyouneed them. To changatha
way a pleture fits in your decument, click it and a button for layout options appears neztto
it. When youwork on a table, click where you want to add a row or a column, and then click

the plus sign.
Chapter One - Style is Evervthing!

Reading iz easier, too, in the new Readingview, You can collapse parts ofthe document and
focus on the text yvou want, If vou need to stop reading before you reach the end, Word
remembers where you left off - even on another device.

“ideo provides a powerful way to help you prove your point. When you click Online Video,
you can paste in the embed code for the video you want to add. You can alsotype a
keyword to search online for the video that best fits vour document.

To make your document lock professionally produced, Word providas header, footer, cover
page, and text box designs that complement each other. For example, you can add a
matching cover page, header, and sidebar. Click Insertand then choosethe elements you




Styles Allow Scalability/Accessibility
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The Basics of Fonts and Font Sizes

Which font is the best one to use?

« Pick one as long as it is a standard Unicode font.

HIII

« The fact that you are making your document accessible means that if “I” can’t see the font or

font size to read it, | can swap out yours for one that works better.

This is why direct formatting is a barrier to accessibility.
- Tells Word that no matter what | say, always keep the text this size in this font.

« Prevents someone from using fonts and font sizes that work best for them.

Avoid large pieces of bold, italic and underline.

« Old typewriter formatting.

Avoid all caps as it is the most difficult font attribute to read by anyone, with or without l

a disability. ~
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Tools for Working with Styles

Apply Styles Pane (Ctrl + Shift + S)

Styles Pane.

Quick Styles Gallery.

Quick Access Toolbar (can put the Apply Styles Pane on the Quick Access
Toolbar so it is easy to work with)

- The keyboard command to access it, if it is the first item after the default items is Alt,
pause then press 5.

|
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Apply Styles Pane
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Quick Styles Gallery and Styles Pane
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Modify the Normal Paragraph Style

- Locate the Normal Style in the Styles Pane, right click or use the AppKey and
choose Modify.

« Change the Font and font size.

- If you are going to change the colour, make sure there is good contrast.




Modify Style Dialog
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Headings are Navigational Structures

« We must start designing our Word documents, not just adding content as we
think of it.

« The document must have a logical reading order.
- Consistent look and Feel.

« Consistent use of Headings:

« Must be sequential, Heading 1 leads to Heading 2 which leads to Heading 3.
- Heading 1 does NOT lead to Heading 3!

- The argument for skipped Headings is one of poor document design.

- Heading Styles will help you ensure that Headings have a consistent look and
feel.




Sample of Headings in a Document

Introduction

Video provides a powerful way to help you prove your point. When you click Online Video,
wou can paste in the embed code for the wvideo you want to add. You can also type a
kevword to search online for the video that best fits your document.

To make yvour document look professionally produced, Word provides header, foctar, cover
page, and text box designs that complement each other. For example, you canadd a
matching cover page, header, and sidebar Click Insertand then choose the elements you
want from the different galleries,

Background Information

Themes and styles also help keep your document coordinated. When yvou click Design and
choose a new Theme, the pictures, charts, and Smartirt graphics change to mateh your
new theme. When yvou apply styles, vour headings change to match the new theme.

Savetime in Word with new buttonsthat show up where vou need them. To change the
way a picture fits in your document, ¢lick it and a button for layout options appears nextto
it. When vouworkon atable, click where vouwantto add a row or a column, and then click
the plus sign.

Chapter One - Style is Everything!

Readingis easier, too, in the new Readingwview, You can collapse parts ofthe document and

focus on the text you want. If you need to stop reading before you reach the end, Ward
remembers where you left off - even on another device,

Video provides a powerful way to help you prove your point. When you click Online Video,
wvou can paste in the embed code for the video you want to add. You can also type a
kevword to search online for the video that best fits yvour document.
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Heading Styles

Ctrl + Alt + number 1 for a heading 1.

« Ctrl + Alt + 2 for a heading 2.

« Ctrl + Alt + 3 for a Heading 3.

- If you use Heading 4-6, you can create a custom keyboard command in your template using “Ctrl +
Alt + 4-6” as those keyboard commands are not taken (They are used in OneNote so contact
Microsoft if you want them in Word!)

- If you don’t like the way a Heading Looks, create a template and modify it!
- Don’t choose a Heading level simply because you like the way it looks.

- Headings have navigational meaning for those of us using screen readers or TTS tools!

« If you need more than one H1, create a new Style based on H1 and call it Heading 1A so it will '
appear alphabetically in the Styles Pane. [
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Modifying the Formatting of a Heading

« Use the same technique as for modifying the Normal paragraph Style.

« Locate the Style in the Styles Pane or Quick Styles Gallery.

« Right click or press the AppKey to get the context menu and choose Modify.
- Select text first so that the Style you want to modify is already highlighted.

- To create a new Heading Style:
- Select text and apply the Heading Style you want a new one for.

- Open the Styles Pane if it isn’t already open and choose New Style button in lower left of the
Styles Pane.

- Make sure that the new Style is named in a way that puts it in alphabetical order.

- Make sure that new Heading 1 is based on Heading 1! l

3 / \\/\>



Create New Style Dialog
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Tables of Content

- Tables of Content use the Heading Styles which in turn adds a second
navigational layer to your document.

« Press Alt+ S, T, C for References Ribbon, Table of Contents, Custom Table of
Contents.

- Do NOT use any of the Tables of Content Gallery items!

« They use Content Controls which are not accessible!

- Keep the defaults and press Enter to generate a Table of Contents.




Why we don’t use Headings to Call Out Text

[ntroduction

Onthe Inserttab, the zalleriesindude items that are designed to coordinate with the averall lookof
yourdocument. You canusethese galleriesto inserttables, headers, footers, lists, cover pages, and
other document buildingblacks. Whenvou create pictures, charts, or diagrams, they alsocoordinate
withyour currentdocument look, You can easily change the formatting of selected text inthe document
text by choosing alookforthe selected text from the Quick Styles zallery onthe Home tab. You canalso
format text directly by usingthe other controls on the Home tab

Most controls offer a choice of using the look from the current theme or using
a format that you specify directly. To change the overall look of your
document, choose new Theme elements onthe Page Layout tab. To change the
looks available in the Quick Style gallery, use the Change Current Quick Style
Set command.

Baoth the Thernes gallery andthe Quick Styles gallery provide resetcormmands sothatyou can always
restorethe look of your document to the original contained inyour currenttemplate. Onthe Inserttab,
the galleriesinclude iterns thatare designed to coordinate with the overall look of your document.

Chapter One

Wou can usethese galleriestoinserttables, headers, footers, lists, cover pages, and other document
buildingblocks Whenyou create pictures, charts, or diagrams, they also coordinate withyour current
document look, ¥ou can easily change the formatting of selected text inthe document text by choosing
alook forthe selected text from the Quick $tyles gallery onthe Horme tab. ¥ou can also formattext
directly by usingthe other contrals on the Home tab. Most controls offer a choice of using the look fram
the currenttheme orusingaformatthatyou specify directly.

To change the overall look of your document, choose new Theme elements on
the Page Layout tab. To change the looks available inthe Quick Style gallery,
use the Change Current Quick Style Set command.

Both the Themes gallery andthe Quick Styles zallery provide resetcommands sothatyou can always
restorethe |ook of your document to the original contained inyour currenttempl ate. Onthe Inserttab,
the galleriesinclude iterns thatare designed to coordinate with the overal | look of your document. ¥ou
canusethese galleries toinserttables, headers, footers, lists, cover pages, and other documentbuilding
blocks

Table of Contents

Introduction 2
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When you apply styles, vour headings change to match the new theme, Savetime in
Word with new buttons that show up where yvou need them, To change the way a picture
fits in wour document, click it and a button for layout options appears next to it. When
vouworkon a table, click where vouwant to add a row or a column, and then click the

History.,

Chapter One 3




Table of Contents Dialog
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Sample Table of Contents - 1

Contents

ContACt I O r I ATIO L —————————————————————————— 4

R U Cots Lo OSSN 4

L 0PSRN 5

ClEATIIE FOTTIATEIIE! cooisii st e s sessssses s s s ssssss st 8 8 10 5

I AIZALION PAILE i RS SRR 7

TempPlates A1 THEILEE i s sssess s sttt e R R8s 9

B 115 T SO 11

Turning off the Word SEArt SOreem. 13

Headings and Custom Headings i s s s s s i 14

Custom Headings. 16
FPutting the Apply Styles Pane on the Quick Access Toolbaru i, 19 -




Sample Table of Contents - 2
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Alt Text on Images, Tables and Equations

- Select the image, table or equation.

- For images/pictures right click or press the AppKey and choose Format Picture, the go to the
Layout icon, expand Alt Text.

- For Tables select the table, right click or press the AppKey and choose Table Properties, then
go to the Alt Text tab.

- For equations select the equation, right click or press the AppKey and choose Format Object,
then go to the Layout icon and expand Alt Text

- Alt Text should be brief, a sentence or two, not an essay.
« We can’t go through Alt Text in the same way we go through regular text in a document..
« Press F6 if focus is not in the Format Picture Pane then press Right Arrow to Layout button,

then Tab into Size, use Down Arrow until you land on Alt Text and Right arrow to open Alt
Text, then Tab to Description and type the Alt Text. l
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Alt Text in the Format Picture Pane

Format Picture vy X
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Captions for Images, Tables and Equations

Select the image, table or equation and right click or press the AppKey then
choose Insert Caption.

Caption

Caption:

Figure 80|

Dptions
Label; Figure

Position: | Below selected item

|:| Exclude label from caption
Meww Label.., Delete Label Mumbering... [

AutaCaption.., (0] 4 Cancel




Contextual Links

Craft the text in the document so that you can select it and make it a link.

 Yes, this might take a bit of thought, but this improves the accessibility of your
documents!

Select the text and press Ctrl + K to open the Insert Hyperlink dialog.

Focus is in the edit box where you can add the link.

- Type or Copy and Paste the web address.

Tab to and press Enter on the OK button.




Insert Hyperlink Dialog - Ctrl + K
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Link Samples

Video provides a powerfulwayto help you prove your point. When you click Online Vidao,
you can paste in the embed code for the video http: / fviralcastrocks fvideos fweag-2-0-
theme-song-web-content-accessibility-guidelines-disability vou want to add, You can also
type a keyword to search online for the wideo that best fits your document.

To make vour document look professionally produced, Weord provides header, focter, cover
page, and text box designs that complement each other. For ezample, youcan add a
matching cover page, header, and sidebar. Click Insertand then choose the elements you
want from the different galleries,

Video provides a powerful wayto help yvou prove your point. When you click Online Vidao,
you catl paste in the embed code for the video youwant to add, You can also type a
keyword to search online for the video that best fits your document,

To make your document look professionally produced, Word provides header, footer, cover
page, and text box designs that complement each other For example, you canadd a
matching cover page, header, and sidebar. Click Insert and then choose the elements you
want, from the different galleries,




Optimize the Accessibility of Tables

Insert a table using the Insert Ribbon and either the Table Gallery or the Insert Table
dialog (Alt+ N, T

« NEVER draw a table!

« Never use a table for design layout!).

- Repeat the Header Row.

- Do not allow rows to break across pages.

« If you need space adjust the Cell Margins do not use Enter key.

- Add a Cation above the table.

 Alt Text for a table is to provide any information about the oddities of a table. If it is [

a uniform table, then this is what | usually put.
V. \\\/\%



Insert Tables
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Header Rows Repeat

Table Praperties ? x

Tahle Raow Column Cell Alt Text
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Dgpecify height: 0" +| R heightis: [& least A4
Dptians
TABLE TOOLS
Sllon oo breslk ackocs maoe
[liRepeat as header row st the top of each page DEZIGM LAYOUT
) 4 ¥
& Previous Row | | Mext Row A_f Al L_Iﬂ -
: Y 0 2l B = A
Teut Cell Sort Repeat  Cormwert Formula

irﬁ:n Mﬁns m Headﬁ%ws t ut 1
1 t Data =

Cancel




Do NOT Allow Ros to Break Across Pages

Table Properties ? >
Table B Calumn Cell Alt Text
Rows 1-3:
Size
Dgpecifyheight: o | Row heightis: |Af least w
Qiptions

[ Jissllows rowe to break across pages:

epeal as header row a e top of each page

& Previous Row ¥ Mext Row




Sample Header Rows Repeat

Table 1 Summary of sales for first two quarters.

Salesperson First Half of 2009 Second Half of 2009
First Quarter Second Quarter Third Quarter Fourth Quarter
Karen 1500 2250 2500 2750
Barnaby 2000 2500 2750 2750
Dlivia 2000 2750 2000 2500
Fred 2000 2550 2570 2750
Salesperson First Half of 2009 Second Half of 2009
First Quarter Second Quarter Third Quarter Fourth Quarter
Dscar 2600 3550 2550 2570
Altnes 2400 3750 2000 2550
Lynda 2500 3650 2250 2750




Cell Tab - Cell Margins

p—
Table Properties ? et
Table oo Column Cell Alt Text
Size
Preferred widthe 2 1R" =1 Measurs int nckes W
Wertical alignr Cell Optians f X

Cell margins

ﬁ []same as the whole table

Top Top: 0 | Left: DO =
Bottom: |10 % Right omm" |2
Options
[] wrap text
[ ] Fit text
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Alt Text for Tables

Table Properties

Table Roonw Column Cell Al Text

Title

Description

This is a uniform table used to display data|

Alternative Text

Titles and descriptions provide alternative, text-based representations of the
infarmation contained in tables, diagrams, images, and other objects, This
infarmation is useful for peaple with wision ar cognitive impairments who
may not be able to see or understand the object,

A title can be read to a person with a dizability and is used to determine
wehether they wish to hear the description of the content,




Changes in Tables - Word 2016

- DO NOT DO THIS!

« Word now uses the Table Tools, Design Ribbon to determine <TH> or Table
Header Tags in a PDF document.

« By unchecking the Header Row and First Column check boxes, you can now use
a table for design layout.

« This has serious consequences for those of us using adaptive technology and has
been a BAD PRACTICE for documents and HTML for years!

Header Row First Calurnn [

[] Total Row [ Last Calurmn
Banded Rows [ ] Banded Columns
Table Style Options




Resources and Contact Info

Free and for purchase resources on accessible document design
and how to contact Karen!




Karlen Communications

« Customizing a Table of Contents.

« Accessible Images for Document.

- Alt Text on Images.
- Contextual Links.
« Optimizing Tables for Accessibility.

« http://www.karlencommunications.com/OfficeForWindowsAccessibility.html

- Creating an Index, Citations and Bibliographies, Track Changes, Footnotes and
Endnotes.

PowerPoint complete with instructions.

A / \\\/\\;

- Conference handout on the Handouts page has an overview of accessible Word and l


http://www.karlencommunications.com/OfficeForWindowsAccessibility.html

Styles In Word: A Primer

 Styles in Word: A Primer for Accessible Document Design

- A primer for anyone starting in the field of accessible document design or
accessible document remediation.

- The book can be purchased using a credit card through the PubCom.com digital
bookstore, http://www.pubcom.com/books/ or by invoice/PO directly by e-
mailing/calling http://karlencommunications.com/contact.htm.

« Itis tagged PDF with option to print entire book or pages, sections, chapters.

|
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http://www.pubcom.com/books/
http://karlencommunications.com/contact.htm

Accessible and Usable PDF, Fourth Edition

- The fourth edition of Accessible and Usable PDF Documents: Techniques for
Document Authors is available!

« The book can be purchased using a credit card through the PubCom.com digital
bookstore, http://www.pubcom.com/books/ or by invoice/PO directly by e-
mailing/calling http://karlencommunications.com/contact.htm.

- Itis tagged PDF with option to print entire book or pages, sections, chapters.



http://www.pubcom.com/books/
http://karlencommunications.com/contact.htm

Contact Karen!

Karen McCall, M.Ed.

Karlen Communications
info@karlencommunications.com
http://www.karlencommunications.com
@Karlenlnfo

Consulting and training on accessible document design (Word, PowerPoint, Excel
and PDF). Advocate for a Global Inclusive Education Standard.

|
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